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PART I GENERAL STRUCTURE 

Chapter 1: Introduction 

1.1 Main components of a GeoDMS project 

A GeoDMS project contains the following components: 

- The GeoDMS Engine (Geographic Data and Model Server), a generic set of DLL's 

that control, retrieve, store and calculate the primary data and model results  

- The GeoDMS GUI, a generic client application that visualizes the primary data, 

the model results and the calculation logic with a set of primary data viewers. 

Furthermore, it supports the user in extending/editing the model logic, 

importing and exporting new primary data and savings all these ‘settings’ in a 

new configuration.   

- The (default) configuration. A hierarchical set of configuration files that describe 

the primary data, the model logic, and the way to visualize both. For this User 

Guide, the Landuse Scanner demo configuration is used. 

- A set of primary data files that are configured in the configuration. 

 

This user guide mainly focuses on the GeoDMS GUI. How to set up a configuration is 

described in the modeler’s guide. Both guides can be found on the website of Object 

Vision (http://www.objectvision.nl/GeoDMS). Information about the example data can 

be retrieved as metadata in the system (see paragraph 5.5, Detail Pages > Metadata).   

 

The GeoDMS GUI is the user interface of the system. As mentioned above the purpose 

of the application is to: 

- View all the primary data and model results. A hierarchical structure is used in 

the configuration to find the requested information (data element). This 

hierarchical structure of so-called tree items is presented in a Treeview. With a 

set of viewers, the primary data, as well as the model logic, can be visualized. 

- Adapt or extend the model logic or the way to visualize data by initiating new 

cases, create new or edit existing expressions and classifications. Also, data 

can be exported in different data formats. 

- Store and retrieve the settings of the visualization of the primary data or model 

results in a desktop or the complete configurations with all calculation rules 

in/from a new configuration. 

 

The GeoDMS GUI is a Windows-based application. This user guide does not describe 

the generic Windows functionality like how to close, maximize or minimize a window. 

For more information on these topics refer to your Windows user guide. An Internet 

connection and installed browser are preferred, as the most actual help can be found 

at the above-mentioned website.  

 

1.2 How to read this guide 

This guide focuses mainly on the end-user, who views the primary data, calculates 

model results, initiates new cases and makes limited extensions and editions to the 

configuration. A detailed description of the structure of the client application, the 

different viewers and the composers are, therefore, described. This user guide does 

not contain sufficient information for modelers to set up a new configuration or a new 

http://www.objectvision.nl/GeoDMS
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calculation scheme. For this purpose, we refer to the modeler’s guide, describing the 

basics on how to configure a model with the GeoDMS. 

 

This user guide is split into two parts. Part 1 describes the generic structure of the 

application, the menu options and the three main panels in the desktop (the Treeview, 

the Detail Pages and the Eventlog). Part 2 focuses on the data viewers that can be 

used to visualize primary data, model results and calculation/model logic.  

 

1.3 System requirements 

See for the latest information on the system requirements the Object Vision website.  

 

1.4 Installation Instructions 

See for the latest installation instruction the Object Vision website.  

http://www.objectvision.nl/geodms/software/system-requirements
http://www.objectvision.nl/geodms/software/installation-instructions
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Chapter 2 Desktop components 

2.1 Main components of the application 

After activating the application, the following window is presented: 

 

 
Figure 2.1: Main window of the GeoDMS GUI  

 

 

In this main window the following components can be distinguished: 

 

 
Figure 2.2: Title bar with the product name and opened configuration 

 

 

 
Figure 2.3: Menu bar with main menu options  

 

 

 
Figure 2.4: An editable item path that can be used to jump to other items (use F5 or mouse-
click to search) 

 

 

 
Figure 2.5: Toolbar with view-specific tools  
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Figure 2.6: Treeview with root item expanded. 

 

 
Figure 2.7: View area in which data viewers can be activated. 

 

 

 
Figure 2.8: Status bar presenting hints and status information. 

 

These components, except for the Treeview and Toolbar, are always visible. The 

Treeview can be closed (and re-opened) with the menu option View>Tree, or with the 

ALT-0 keyboard combination, the toolbar with the ALT-3 keyboard combination. 

 

Two more components are always positioned at a fixed location. The Detail Pages, to 

be opened and closed with the menu option View>Detail Pages, or with the ALT-1 

keyboard combination, are always positioned at the right side of the main window. The 

following figure shows an example of the Detail Pages for the root item:    

 

Figure 2.9: Detail Pages opened for the root tree item 

 

The Detail Pages are a set of tabs that present information on the selected Treeview 

item. These pages will be described in detail in chapter 5. 
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The third component that is always opened at the bottom of the main window is the 

Eventlog view. This view can be opened and closed with the menu option View> 

Eventlog, or with the ALT-2 keyboard combination. The view shows the events that 

are executed by the application, as presented in the following example: 

 

 
Figure 2.10: Eventlog view with start-up events of the GeoDMS GUI 

 

This Eventlog is mainly interesting for experienced users to analyze which actions are 

executed. The messages occurring in this log will not be described in this guide. 

 

The three mentioned components (Treeview, Detail Pages and Eventlog) have a fixed 

position. The size of these components can be adapted with a minimum and maximum 

size. The appearance of these components, the width of the Treeview and the Detail 

Pages and the height of the Eventlog is stored in the user-specific configuration 

settings of the registry. This means the next time the application is opened, the size 

of the components will be maintained.  
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Chapter 3: Treeview 

3.1 Introduction 

The Treeview is the main navigation component of the application. It presents the 

hierarchical structure of a configuration in a view like the Windows Explorer. By default, 

the root and the first level items are shown (the root item is expanded). Each item in 

the tree (called a tree item) is presented with a name and an icon. The main function 

of the icons is to show the default viewer for each tree item. In paragraph 3.2 these 

icons are explained. 

 

The selected item in the Treeview is the active item in the application. This is an 

important concept, as many functions of the application work on the active tree item. 

By clicking the right mouse button a pop-up menu can be activated, with a set of menu 

options that work on this active tree item. This also applies to most main menu options 

and to the Detail Pages. The pop-up menu options and most main menu options are 

described in chapter four. The Detail Pages are described in chapter five. 

 

3.2 Icons used in the Treeview 

The main purpose of the icons is to show which default viewer is used for an item. 

Double-clicking or pressing the Enter key on a selected tree item activates this viewer. 

The following icons are used to indicate this default viewer: 

 

 A data item that can be viewed on a map. This implies the domain of the data 

item has a geographic relation (see modeler’s guide for how to configure a 

geographic domain unit). Dependent on the geographic domain, the data is 

visualized in a grid, point, arc or polygon layer. 

 A data item that cannot be visualized on a map (it has no geographic relation) 

but can be viewed in a Table.  

 

The following two icons do not indicate the default viewer but indicate data items with 

a specific function (classifications and palettes, see chapter 10). 

 

 A data item that contains a classification (a set of classes). A classification can 

be made or edited with the classification and palette composer, see chapter 10 

 A data item that contains a palette (a set of color values that correspond to a 

classification). A palette can be edited with the palette composer, see chapter 

10 

 

Not all tree items are data items. For the non-data items (these items cannot be viewed 

with a primary data viewer), the following icons are in use: 

 

 A tree item with no data items and subitems that also have no data items. The 

icon is used for containers grouping other containers or units.  

 A tree item with no data item, but with data items as subitems. All subitems of 

this item with the same domain unit can be viewed in a Table. 

 A tree item with no data item and no subitems, e.g. a unit  
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Tree items can have a different status and have corresponding text colors, three status 

types are distinguished: 

1. Valid (blue): the results are calculated and the integrity checks configured for 

the item and its suppliers are met. 

2. Not Calculated (pink): the items are not checked and not calculated. 

3. Failed (red): the application failed in updating the results or the integrity checks 

are not met. In the first case, the results are not available; an error is raised 

indicating what problem occurred while updating the tree item. In the second 

case, the results are available and can be presented in a view; a warning color 

indicates the results are not valid. 

 

The application controls when and how to update tree items. If a user requests a view 

on a data item, the required tree items are first updated, before the results are 

presented in the view. If a tree item has become valid, this status is ‘stored’ until 

changes are made in the calculation rules. This means the second time the same view 

(or another view requiring the same data items) is requested, the data item is already 

valid and the results can be visualized immediately. 
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Chapter 4: Main and pop-up menu options 
 

4.1 Introduction 

The main and pop-up menu options are related. With the pop-up menu options, the 

user can activate functions on the selected tree item. The related main menu options 

also function on the selected tree item. The main menu additionally contains a set of 

generic functions like saving a configuration or tiling the viewer windows. In this 

chapter, the main menu options are described. If the option can also be activated from 

the pop-up menu option this is indicated by (P). Some options can only be activated 

from the pop-up menu, this is also indicated. 

4.2 Menu options 

4.2.1 File Menu 

 

 
Figure 4.1: File menu 

 

Open Configuration File: Open a Windows file dialogue to select a new configuration. 

The current configuration is closed with a question whether the changes must be 

saved.  
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Save Configuration As: Open a Window file dialogue to specify a new root 

configuration file (or select an existing root configuration file that will be overwritten). 

In subdirectories, the whole configuration will be saved. If a configuration is saved to 

a file that is read-only, or if its configuration files in a subfolder are read-only, an error 

is raised. 

 

Reopen current configuration: Reopens the current configuration with the current 

and active expanded item and desktop. If a configuration is edited, this way the 

configuration can easily be reopened in the same state. 

 

New Desktop: Create a new desktop, based on a desktop template. A desktop is 

defined as the set of opened map and data viewers, including the specification of the: 

- set of layers and their order in each map view with the properties  

- visible 

- for thematic layers, the used classification  

- The area of interest in each map view  

- The set of columns, column widths and sort order in each Table   

 

After activating this option, a dialogue is presented in which a desktop template can 

be chosen. This offers the possibility of making a new desktop, based on an existing 

desktop functioning as a template. If no desktop templates are available, only the 

empty desktop option can be activated to make a new desktop. In the next dialogue, 

a name must be specified for the desktop. The active desktop name is presented in 

the status bar of the application:  

 

Open Desktop: Open a dialogue to select a desktop from the available desktops in 

the current configuration. The selected desktop is opened. 

 

Set Startup Desktop: Open a dialogue to select a desktop in the current configuration 

that is used as start-up desktop each time the current configuration is opened. 

 

Save Desktop to file: Saves the desktops in the active configuration to a separate 

configuration file. 

 

Export Primary Data (P): Export primary data to a bitmap, .dbf (or Shapefile), ASCII 

grid or .csv file. The option is only active for the relevant data items. Select the menu 

option and choose from the submenu the requested data format. If configured, exports 

of primary data can be accompanied by a .ini or .xml file, containing meta 

information on this primary file. See paragraph 9.3.1 of the modeler’s guide for 

more information on how to configure metadata files.  

 

Export Viewports: Exports the set of opened viewports to bitmaps. A viewport is the 

part of the map view, in which the actual geographic data is shown. The export settings 

(including export directory and file names) are configured in the ExportSettings 

configuration. Activating this option results in a new dialogue, in which all active 

viewports are shown and selected. From this list, you can also select a subset of the 

viewports to be exported. Information about the number of pixels/bitmaps per 

viewport is also presented.  

 

Recent configurations: The recently opened configurations are presented, to easily 

select one of these configurations. The number of configurations is limited to nine. 

 

http://www.objectvision.nl/geodms/modellers-guide/9-exports
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Exit: Exit the application. 

 

4.2.2 Edit Menu (only in Administrator mode) 

 

 
Figure 4.2:  Edit menu 

  

Config Source (P): Edit the config source of an item with the DMS editor (Notepad 

++ or Crimson Editor is advised, see here). The editor needs to be specified in the 

Tools > Options > General Settings > DMS editor option (see 4.2.5). The DMS editor 

is activated with the relevant dms file and if supported by the editor, the correct line 

and position. After editing and saving, use the File > Reopen current configuration 

open to open the configuration in the same state (expanded and active item and 

desktop).  

 

Definition (P): Activate 

- The Edit Classification and Palette dialogue if the selected data item is a 

classification class’s item. See chapter 10 for more information on 

classifications and palettes.  

- The Edit Palette dialogue if the selected data item is a color palette. 

- The Expression dialogue for all other items. This dialogue is used to set or edit 

the expression of a tree item. See chapter 16 for more information on the 

Expression dialogue. 

 

Classification and Palette (P): Activate the Edit Classification and Palette dialogue 

for all data items for which a classification and palette is configured. This classification 

and palette can be configured for the data item itself or for its values unit. See chapter 

10 for more information on classifications and palettes. 

 

Update TreeItem (P): Update a data item with the status invalidated. The option is 

only enabled for invalidated data items. The result of the action can be a valid data 

item (update succeeded) or a failed data item (update raised an error).  

 

Update Subtree (P): Update the subitems of a tree item. The option is only enabled 

for tree items with invalidated subitems. The result of the action can be a valid set of 

subitems (update succeeded) or one or more failed items (update raised an error).    

 

http://www.objectvision.nl/geodms/software/configuration-file-editor
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Invalidate TreeItem (P): Explicitly invalidate an item to ensure it will be recalculated 

when the results are requested in a view. 

 

Copy TreeItem (P): Copy a tree item to the Windows clipboard, to paste the item 

into another container. 

 

Paste TreeItem (P): Paste a copied tree item with the same name. An item needs 

to be copied first before the paste option becomes enabled. As two tree items with the 

same name are not allowed in the same container, a copied item cannot be pasted in 

the same container (the option is disabled). Be aware: Pasting items in a new container 

can cause invalid tree items (e.g. because the container of the copied item a using or 

storage property was configured, which is not a property of the copied item and, 

therefore, not copied to the new item). Primary data is not copied; therefore, the 

copy/paste functionality cannot be used to make a copy of a classification. Use the 

save as function in the edit classification and palette dialogue for this purpose. 

 

Delete TreeItem (P): Delete a tree item with all its subitems. If a tree item cannot 

be deleted, because it is referred to by other tree items, (e.g. in an expression), a 

message is presented indicating the item could not be deleted. First, delete the 

referring tree item before the referred tree item can be deleted. Still deleting tree 

items can cause some incorrect working functionality. Be cautious with deleting tree 

items, especially with items referred to from multiple places. 

 

Edit Label ActiveWindow: The Active View (see part II of this reference for 

information on viewers) can be provided with a label, indicating the contents of this 

view. The menu option becomes active if a view is opened. In a text box, a view label 

can be given. The view label is presented in the title bar of the view.  

     

4.2.3 View Menu  

 

 
Figure 4.3:  View menu 

 

Default (P): Activate the default viewer for the selected data item. This option is only 

enabled for data items. The default viewer for all data that can be visualized in a map 

is the map view. For all other data items, the default viewer is the Table view. 

 

Map (P): Activate the map view for the selected data item. In a submenu, the layer 

type must be chosen (in this version only default is implemented). See chapter 7 for 
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more information on the map view and the layer types. The map view option becomes 

enabled if the selected data item can be visualized in a map view. 

 

Table (P): Activate the Table for the selected data item. See chapter 8 for more 

information on the Table. The Table option becomes enabled if the tree item can be 

visualized in a Table. 

 

Histogram (P): Activate the histogram for the selected data item. See chapter 9 for 

more information on the histogram. The histogram option becomes enabled if the tree 

item can be visualized in a histogram. 

 

Process Schemes (P) (only in Administrator mode): Activate the process scheme 

for the selected tree item. In the submenu, the process scheme type must be selected.  

 

Treeview: Show or hide the Treeview at the left side of the main window. See chapter 

3 for more information on the Treeview. 

 

Detail pages: Show or hide the Detail Pages at the right side of the main window. 

See chapter 5 for more information on the Treeview. 

 

Event log: Show or hide the Eventlog window at the bottom side of the main window.  

 

Toolbar: Show or hide the toolbar at the top side of the main window. 

 

4.2.4 Insert Menu (only in Administrator mode) 

 

 
Figure 4.4: Insert menu 

 

The first four menu options insert items or sets of items at the location of the selected 

tree item: 

 

Container (P): Insert a new container as a subitem of the selected tree item. The 

Insert container dialogue is activated. See chapter 12 for more information on 

containers and this dialogue. 

 

Data Item (P): Insert a new data item as a subitem of the selected tree item. The 

insert data item dialogue is activated. See chapter 13 for more information on this 

dialogue. 

 

Entity/Unit (P): Insert a new entity or unit as a subitem of the selected tree item. 

The Insert Entity/Unit dialogue is activated.  
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External Data Link (P): Insert a link to an external data source, this is implemented 

for ASCII grids, dBase files, ODBC sources and Shapefiles. They will be configured as 

subitem(s) of the selected tree item. 

 

The two options below the line insert sets of items at a pre-defined, configured location 

in the tree. This location is configured in the config.ini file accompanying each 

configuration. The location is independent of the selection of the active tree item. 

 

Template Instantiation (P): Insert a new instantiation of a template. A dialogue is 

presented to specify the parameters for this instant ion. 

 

Classification and Palette (P): Insert a new classification and palette in the 

classification container. The Insert Classification and Palette dialogue is activated. See 

chapter 10 for more information on classifications, palettes and this dialogue. 

 

 

4.2.5 Tools Menu 

 

 
Figure 4.5: Tools menu 

 

Options: activate the following dialogue to set some general properties: 
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Figure 4.6: General settings dialogue 

 

The dialogue is split up into three tabs. The General settings tab is used to configure 

settings that apply to all configurations. These settings are stored in the user-specific 

registry setting. The Current configuration tab is used to configure settings that apply 

to the current configuration. These settings are stored in the configuration specific 

config.ini files. The ConfigSettings tab contains configuration specific setting that can 

be overruled for the local machine. These settings are stored in the registry.   

 

In the General settings tab the following settings can be configured: 

URL:  The URL that is used in the about box for more information on the data and 

model server 

 

Helpfile: the URL that is used for online help on the data and model server. 

 

It is not recommended to change the URL and Helpfile settings. 

 

DMS editor: the path to an external text editor, including some parameters for how 

to position the cursor at a specific location in a configuration file. This functionality is 

used if errors occur in the configuration. If a text editor is configured, the GeoDMS 

GUI can open the configuration file and, if supported by the editor, indicate to the 

position in the file where the error was noticed. The following parameters can be set: 
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%F: file 

%L: line number in the file 

%C: column number in the file 

The exact syntax for the configuration depends on the used editor, see here. 

 

User modes: The application can be configured in two modes: 

- User mode. The administrator mode check box is not selected . 

- Administrator mode. The administrator mode checkbox is selected . 

 

There are three differences between both modes: 

- Hidden tree items. A tree item can be configured hidden by configuring the 

DialogType property to hidden. In the user mode, these items are not shown 

in the Treeview, the Detail Pages and the process schemes. In the administrator 

mode, all items are shown. 

- The menu (and pop up menu) options Edit and Insert are only available in the 

administrator mode. 

- Editing the properties. In the user mode, the dialogues are used to set 

properties for specific tasks. The properties in the detail page Properties (A) 

cannot be edited. In the administrator mode, some of these properties can be 

edited. Be aware that editing properties in this dialogue can make the 

application unstable. 

 

If the Administrator mode is selected, the following options can be selected: 

1. TraceLogFile. If this option is selected, a trace.log file is generated by the 

application. The trace.log file logs information about the calculation processes 

and can be used for debugging purposes. If the option is not selected, the file 

is not generated. 

2. Show State Colors in Treeview. This option shows the state of an item (as 

described in & 3.2), visualized in different colors in the Treeview. The colors 

can be configured in the Current configuration tab. The color for valid items 

cannot yet be specified (default green). 

3. Suspend View Updates to favor User Interaction. This option allows a user to 

interact with the system, even if the system is calculating results or updating 

views. The option can cause some errors and is therefore not supported in the 

user mode.  

4. Parallel Processing 1(tile based) and PP2 (multiple calculation steps 

simultaneously). These options are implemented to support multi-threading (in 

development). It is advised to keep these options to the default settings for the 

GeoDMS version.   

 

LocalDataDir:  

The LocalDataDir is used as the base directory for (temporary) results like the 

CalcCache. See http://www.objectvision.nl/geodms/directories-and-placeholders 

for more information on directories and placeholders in the GeoDMS. The default 

setting for the LocalDataDir is C:\LocalData. This default setting can be overruled here. 

 

SourceDataDir: 

The SourceDataDir is used as the base directory for (large, read-only) sourcedata files, 

often used in multiple projects. See http://www.objectvision.nl/geodms/directories-

and-placeholders for more information on directories and placeholders in the GeoDMS. 

The default setting for the SourceDataDir is C:\SourceData. This default setting can 

be overruled here. 

 

http://www.objectvision.nl/geodms/software/configuration-file-editor
http://www.objectvision.nl/geodms/directories-and-placeholders
http://www.objectvision.nl/geodms/directories-and-placeholders
http://www.objectvision.nl/geodms/directories-and-placeholders
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The Current configuration tab presents the following dialogue: 

 
 figure 4.7: Current configuration dialogue 

 

No-data color: Activate the button to select the no data color in the map views of the 

current configuration. 

 

Background color: Activate the button to select the background color of the map 

views of the current configuration 

 

TreeItem View Color Settings: Default these options are disabled. If in the General 

settings page the Administrator mode is selected, the option: Show State Colors in 

Treeview can be selected. The state of an item (as described in & 3.2) is then visualized 

in different colors in the Treeview. The colors for Valid, Invalidated or Failed items can 

be selected in this dialogue. 

 

Default Classification Ramp Colors: In the classification and palette composer (see 

chapter 10), colors are default chosen for the first and the last class. These colors can 

be selected with this dialogue. 

 

Minimum size for DataItem specific swap files in CalcCache: This setting is used 

to indicate the size of items that need to be saved in the CalcCache on disk. In general, 
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it is advised to keep this setting. See http://www.objectvision.nl/geodms/calccache-

guide for more information. 

 

Threshold for Memory Flushing wait procedure: a threshold value that indicates 

at which percentage of use of the internal memory the GeoDMS should start with 

flushing memory to keep the system responding. In general, it is advised to keep this 

setting. 

 

The ConfigSettings tab presents a following dialog: 

 

 
 Figure 4.8: ConfigSettings dialog 

 

The presented settings in this dialogue result from the items configured in the 

/ConfigSettings/Overridable container of a project configuration. The values in the blue 

boxes correspond to the values configured in the project configuration. The values in 

the dark green boxes are overruled for the local machine (and stored in the registry). 

With the Reset button, they can be reset to the configured values. 

 

 

 

  

http://www.objectvision.nl/geodms/calccache-guide
http://www.objectvision.nl/geodms/calccache-guide


  User Guide GeoDMS GUI 7.180 

 

 22 

4.2.6 Windows Menu 

 

 
Figure 4.9: Windows menu 

 

Tile Horizontal: Tile the currently opened data viewers horizontally. 

 

Tile Vertical: Tile the currently opened data viewers vertically. 

 

Cascade: Cascade the currently opened data viewers. 

 

Close all: Close all currently opened data viewers. 

 

Windows: A list of all opened data views, the active view is indicated by a dot. 

A view can be activated from this list. 

 

 

4.2.7 Help Menu 

 

 
Figure 4.10: Help menu 

 

Online Help: Open the Internet Browser installed on the local machine with the URL 

specified for the Help file in the Tools > Options dialogue.  

 

About: Open the About box for information on the version and development team of 

the application  

 

Index: An optional reference to an index of relevant documents for an application 

 

Copyright Notice: An optional reference to the Copyright information for an 

application 

 

Disclaimer: An optional reference to a Disclaimer for an application 
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Data Source Reference: An optional reference to a description of the data sources, 

to be used in reports with results of the application.  
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Chapter 5: Detail Pages 
 

The Detail Pages present a detailed overview of information on the selected tree item.  

 

The Detail Pages show (generated) HTML documents, like an Internet Browser, with 

hyperlinks and a back and forward button. If the text refers to a tree item, clicking the 

hyperlink means this item is activated. If the text is the label of a property, a dialogue 

is presented related to this property.  

5.1 General 

This page presents the most relevant properties of a tree item and its related domain 

and values units (if applicable). The following example shows the General page for the 

tree item: Geography/RegionalUnits/Province/Shapes/area  

 

 
Figure 5.1: General (G) detail page  
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This Detail page shows: 

- The full name, status, label, description and values type of item and if 

configured the class diagram to be used for classification of the data. 

And, if the tree item is a data item:  

- A calculation rule (expression) for a data item for which an expression is 

configured. The ParseResult and CacheEntry are based on this calculation rule.  

- A storage for a data item read from a data source, with an indicator if the 

storage is ReadOnly (label ReadOnly = 1) or read and write (label ReadOnly = 

0) and optional a SqlString. 

- The Domain Unit for which the item is available, including the element type, if 

relevant the geographic projection and the range (nr elements) of the domain.  

- The Values Unit in which the data item is configured, including the element 

type, the metric, the range of the values, the number of elements and, if 

configured, the classification scheme for the values unit. 

5.2 Explore  

The Explore detail page shows the name, description and storage type of the items in 

the NameSpace of the selected tree item. The following example shows the Explore 

detail page for the tree item: Units 

 

 
Figure 5.2: Explore detail  
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5.3 Properties  

This page shows all properties of a tree item. The following example shows a part of 

the properties detail page for the TreeItem: geography/RegionalUnits/province/shapes  

 

  
Figure 5.3: Properties detail page  

 

The Properties page shows all relevant properties of the selected item, including 

system properties, indicated by the keywords CLASS. By double-clicking on a property 

row, a dialogue is activated with the whole text of the property and its current value, 

as shown in the following example for the property full name: 

 

 
Figure 5.4: Textbox presenting the full name of the selected tree item    

 

This text box can be used to copy information to the Windows clipboard. In the 

administrator mode (see chapter 4, menu option Tools > Options > Administrator 

mode), the textbox can also be used to set values for some properties. This 
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functionality is only advised for experienced users, as setting incorrect values for 

properties can create an unstable system, resulting in multiple errors. 
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5.4 Metadata 

For more information on a tree item, an URL property can be configured that refers to 

a document on the local machine or on the web. The document (which can be a .html 

file or any other file format that is supported by Internet Explorer and which application 

is installed on the local machine, like MS Excel, MS Word, etc.) is presented in the 

detail page Metadata. An example for the RuimteScanner item: 

/StudieGebieden/Nl2008/brondata/Beleid/Ruimte/STREEKPLANNEN/streek10 

 

 

 
Figure 5.5: part of Metadata detail page  
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The metadata detail page can also be used to specify the export settings for exporting 

map viewports to bitmaps. Open the metadata detail page on the item: ExportSettings 

 

 
Figure 5.6: Metadata detail page for item ExportSettings 
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In this dialogue the following options can be configured: 

 

Size 
- Paper size:  

The paper size defines the export area of the resulting bitmap. The following 

options are available: 

- map window size: the export area is the area of interest visible in the map 

view 

- A specific paper size: the export is based in the center point of the area of 

interest in the map view and the selected paper size. 

- User-defined: the width and height options become enabled. The export is 

based in the center point of the area of interest in the map view and the 

specified paper width and height. 

- Orientation:  

For specific and user-defined paper sizes, this option indicates if a landscape or 

portrait export is desired. 

- Margins: 

For specific paper sizes, margins can be set. The margins influence the width 

and height of the resulting bitmap. 

 

 

Scale 
The user can define the scale of the resulting map view with the following options: 

- User-defined: the 1 to .. option becomes enabled to indicate that 1 cm in the 

map is the specified value in cm’s in the real world 

- Based on map windows: the same scale is used as in the exported map 

window 

- A specific scale: the available options are the ‘optimal’ scale levels for the 

background map layers. It is recommended to use one of these scale levels, for 

the nicest map results. 

 

 

Quality 
- Dots per inch(dpi): 

This quality setting indicates how many dots will be printed per inch, based on 

the allowed dpi of the printer. Increasing this number results in better quality 

maps (if supported by the printer), but also results in more/larger bitmaps. MS 

Office products like PowerPoint usually assumes images to be around 100 dpi, 

this means the image size needs to be adjusted if files with larger dpi are 

imported. 

- View distance factor: 

A factor indicating if the result is to be seen at the distance of a screen of e.g. 

of a poster, which is usually looked at from a larger distance. A large view 

distance factor means the objects in the map are presented larger. The default 

value is 1. 

- Subdots per paper dot: 

For future use, the default value is 1  

 

After adjusting these values, activate the save settings button to save the settings for 

the current session. If the application is ended, these settings are not saved to the 

configuration. The next time the application is run, the original settings apply again. 
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5.5 Statistics 

This detail presents general statistics about a numeric data item. The example presents 

the detail page for the item: Current_Situation/Current_landuse/predominant_2010 

 

  
 
Figure 5.7: Detail page Statistics 

 

In this page the following statistics are presented: 

ValuesMetric:  the metric of the values unit of the data item (if specified) 

ValuesType:   the value type of the values unit of the data item 

 

Count:     number of items of the data item 

Maximum:     maximum value of the data item 

Minimum:     minimum value of the data item 

Sum:      sum of all values of the data item 

Average:     average value of the data item 

Variance:     variance of the data item 

StdDev:    standard deviation of the data item 

Nr Nulls:     number of missing data elements of the data item 

Nr Values:     number of non-missing data elements of the data item 
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The Statistics is only shown if the data item is valid (as it can take some time to update 

a tree item). If the item is not yet calculated, a message is shown that the data item 

is invalidated. In that case, press the Ctrl-U combination to update the tree item first. 

If the item is not a data item or not numeric, a message is shown which indicates the 

statistics cannot be shown. 

 

The results in the Statistics view can differ slightly from calculated aggregated values. 

The Statistics view calculates all present values in a float64 format. If an aggregation 

is performed on a float32 data item, the results are round off after the calculations to 

a float32 format.   

 

5.6 Value Info 

 

The construction of a data value in the Table or map view is activated by selecting a 

cell in the Table or by activating the I-tool in the map and selecting a certain grid cell 

in the map. If the value info page is the active detail page, all the steps are presented 

on how a data value is constructed from the source data and the performed 

calculations: 

 

 
Figure 5.8: construction of a data value in the data grid view for the tree item: 
/Geography/RegionalUnits/DijkRing/Shape_rel 

 

If e.g. the cell with the value 17 is selected in the table and the detail page info value 

is active, the information as shown in the example is presented. This information 
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describes how the value is calculated and which suppliers are used. The next sentences 

indicate the values of the suppliers. Use the hyperlink to find out how these values are 

calculated and what their suppliers are.  

5.7 Configuration 

The configuration tab shows the configuration syntax of the selected item (and if 

available, it’s subitems). The following example presents the configuration detail page 

for the tree item:  Units/Eur_Ha 

 

 
 Figure 5.9:  Detail page Configuration  

 

More information on how to configure with the GeoDMS can be found in the modeler’s 

guide on http://www.objectvision.nl/geodms/modellers-guide.  

 

5.8 XML 

The XML tab shows the XML configuration syntax (.xml) of the selected item (and if 

available, it’s subitems). The following example presents the XML detail page for the 

tree item: Units/Eur_Ha 

 

 
Figure 5.10:  Detail page XML 

 

http://www.objectvision.nl/geodms/modellers-guide
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5.9 Source Description 

 

This detail page describes, if relevant, information about all sources used to calculate 

a data item. If a source property is configured for a data item, this information is 

presented, of not the data sources names(files) is presented. An example is shown in 

the next figure: 

 

 
Figure 5.11 Detail page Source Description 
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PART II VIEWERS 

Chapter 6: Introduction 

6.1 Data visualization 

The set viewers in the GeoDMS GUI are used to visualize source data and calculated 

model results. As most data in the applications are geographically related, the main 

viewer is the map view. This map view is configured as the default view for all items 

that are geographically related. More information on the map view can be found in 

chapter 7. The default view is activated by double-clicking on a tree item, by selecting 

a tree item and pressing the Enter key or by activating the default view action from 

the main or pop-up menu. The default viewer for data items is indicated in the 

Treeview by the presented icon (see paragraph 3.2). 

 

For data items that cannot be visualized in a map (like a parameter), the default view 

is the Table. All data items can be visualized in a Table, by activating the Table view 

main or pop-up menu item. The Table is described in detail in chapter 8. The third type 

of view that can be applied to primary data is the histogram view. This view is not 

configured for any item as the default view but can be activated with the histogram 

view main or pop-up menu item. The histogram is described in chapter 9. 

 

As well as the views for the primary data, the GeoDMS GUI also offers views on the 

configured calculation and model logic. Therefore, the so-called process schemes are 

implemented, allowing the user to get a scheme of the subitems, suppliers and 

calculation logic of a tree item. These process schemes are described in detail in 

chapter 10. 

 

All views are positioned in the view area of the application. The first view is always 

opened maximized. Be aware that the minimum, restore/maximize and close buttons 

of this view are located at the top right corner of the window in the main menu bar, 

as shown in the next figure: 

 

 
Figure 6.1: Map view  
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If a second view is opened, this view is opened maximized if the other views are also 

maximized. Otherwise, the window is opened in the normal Windows state. 

 

Each viewer has its own set of tools in the taskbar when the view is activated. In Figure 

6.1 the tools of the map view are presented. All views are listed in the Window main 

menu option. With this menu option the views can be tiled, cascaded and all windows 

can be closed.  
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Chapter 7: Map View 
 

7.1 Introduction 

The map view presents data items that can be geographically located. Each map view 

has a projection, indicating the coordinate system. In Dutch applications, the 

projection used is usually the "Rijks Driehoek (RD)" coordinate system for all 

geographically related data items (other coordinate systems are possible, but the 

source data is usually in RD Coordinates). A map view consists of layers, each layer is 

related to one or more data items. All geographically related data items using the same 

projection can be combined in the same map view window. They can also be opened 

in multiple separate map views. The number of opened map views is not limited. 

 

In the example of figure 6.1 a map view is presented with three layers: 

- Two reference layers with province boundaries and with a top100 grid. 

- A dominant land use thematic grid layer.  

  

In paragraph 7.2 the available layer types for a GeoDMS map view are described. A 

map view can be activated from the Treeview by selecting tree items that can be 

geographically related. These items are indicated with a map icon ( ).  

 

A new map can be created or a layer can be added to an existing map by selecting a 

tree item and activating one of the following actions listed in the table. The result of 

the action, based upon whether there is already an active map view opened, is 

described. 

 

Action No active map view  Active map view 

Double click on selected tree 

item  

New map window Layer opened in active 

map view with same 

coordinate system 

Enter key on selected tree 

item 

New map window Layer opened in active 

map view with same 

coordinate system 

Main/pop-up menu option 

Default View 

New map window Layer opened in active 

map view with same 

coordinate system 

Main/pop-up menu option 

Map View  

New map window New map window 

Ctrl-M on selected tree item New map window New map window 

Drag and drop to view 

area/active window 

New map window Layer opened in active 

map view with same 

coordinate system 

 

A reference grid layer can be configured as a background layer. This means in all map 

views this layer is visualized automatically when the view is created (see the modeler’s 

guide for how to configure a default layer).  
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7.2 Layer types 

In a map view, layers can be visualized in different ways. Within the GeoDMS a 

difference is made between: 

 

Reference/background layers:  

 

 

 

 

 

 

 
Figure 7.1: Examples of reference/background layers with polygons/labels and grid data 

 

Layers that are used to refer in an intuitive way how the data is to be visualized. 

Reference layers are usually: 

- topographic polygon layers (showing the boundaries of areas like in the 

example above), sometimes with a label configured (as in the example) 

- Grid layers which can present different detail information at different zoom 

levels. 

 

In GeoDMS applications one or a set of reference layers is often configured as default 

layer (see the modeler’s guide for how to configure a default layer). The default layer 

(set) has by default one entry in the legend.  

 

Attribute data layers: 

Layers use to present data related to a geographic domain. This domain consists of 

geographic objects, which can be grid cells, polygons, arcs or point as in the following 

examples:  

Figure 7.2: Examples of attribute data layers with grid, polygons, arcs and points data 

 

In these layers, the features (grid cell, polygon, arc, point) are visualized with one or 

multiple visualization styles (colors, symbols, size etc.). The possible styles are 

dependent on the layer type. The style values refer to classes in a classification 

scheme. This implies that a palette (e.g. color, size, symbol) and, if the data item is 

not yet classified, a classification is needed to visualize a data item as a thematic layer. 

If no classification is found for the data item or its values unit (see chapter 10 for more 

information), a data item cannot be visualized thematically. 

 

Layers can be activated with the actions listed in paragraph 7.1. The grid layer type is 

activated for each numeric data item with a grid domain as domain unit. For the vector 

data types (polygon, arc and point), the geographic format specified for the values 

unit of the feature data item, determines if the data is visualized as point, arc or 

polygon (see the modeler’s guide how to configure these values types). 
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A specific theme of a layer is a text label. Text labels can be used for polygon and 

point layers.  

 

 

  

   

 

 
Figure 7.3: Examples of labels for polygon and points layers 

 

 

7.3 Active Layer 

The active layer is an important concept in each GeoDMS map view. The active layer 

is the layer on which the layer-specific (toolbar) functions are executed.  

 

A layer can be activated from the legend (see 7.5). In this legend the active layer is 

indicated by a blue background color in the title as in the next figure (the last column 

contains the counts): 

 

 
Figure 7.4: Examples of an active layer in the Legend 

 

The user can switch between active layers by clicking on the layer title. There is always 

only one active layer (activating one layer deactivates all other layers). By default, the 

last layer added to the map view becomes the active layer. 

 

7.4 Tools  

When a map view is then activated, the set of specific map view tool buttons is 

presented in the toolbar. By default, the ‘Zoom in’-tool is activated, as this is often the 

first action performed. For the neutral state (arrow that performs no action on the map 

view) deactivate the zoom or selection state by re-clicking on the same tool. 

   

The following buttons are available to adapt or query the map view (not all tools might 

be visible for a specific project, this can be configured in the config.ini file): 

 

  

 

Fit to all layers: action to enlarge or reduce the zoom level and pan the area to make 

the extents of all layers fit in the active map view. 

 

http://www.objectvision.nl/geodms/software/installation-instructions/overruling-directories
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Fit to active layer: action to enlarge or reduce the zoom level and pan the area to 

make the extents of the active layer fit in the active map view. 

 

 

 

Zoom in: zoom in tool, presenting the cursor as a magnifying glass with a plus sign, 

which can be used to zoom in, in two ways: 

- Click with the left mouse button at the top left corner of the requested area of 

interest. Keep the left mouse button pressed and move the mouse to the 

bottom right corner, a rectangle is drawn on the map. Release the mouse 

button and the map zooms into the requested rectangle. 

- Click with the left mouse button on a position in the map and release the button. 

The map is zoomed in with a fixed zoom factor and the cursor position as center. 

The Zoom in tool is configured as default tool. The neutral state (no tool active) can 

be achieved by activating this button. 

 

 

 

Zoom out: zoom out tool, presenting the cursor as a magnifying glass with a minus 

sign, which can be used to zoom out until the full extent of the map is reached. Click 

with the left mouse button on a position in the map and release the button. The map 

is zoomed out with a fixed zoom factor and the cursor position as center. 

 

 

 

Pan: pan tool, presenting the cursor as a semi-transparent hand sign, which can be 

used to move the presented layers. To pan, click with the left mouse button at a 

position in the map, keep the left mouse button pressed and move the mouse to the 

requested direction. Release the mouse button and the requested new area of interest 

is drawn. 

 

 

 

Info: information tool, presenting the cursor as an arrow with an i-sign, which can be 

used to query individual features in the map of the active layer (see 7.3). To query 

the values of individual features, click with the left mouse button on the requested grid 

cell, point, arc or polygon. The feature is shown in a new color. The information of this 

feature is shown in two ways: 

- In the legend, the values of the attribute of the active layer and all grid attribute 

layers are presented in front of the values unit or in a separate line. 

- If the value info detail page is visible, the whole path for how the value in the 

map view is constructed is presented (see paragraph 5.6 for more information 

on the value info Detail Pages). 

The information tool is related to the active cell in a data grid of the same domain unit 

as information is requested from in the map view.  

 

The following six tools are used to (de)select objects. The selected features of 

polygons, arcs and points are colored light blue. For grid cells, a hedge style for both 

interior as the border is used to indicate selected cells. 
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Selected features are by default added to the earlier selection. Keep the Control key 

pressed to deselect features. Activate the ‘Select none’-tool to reset the whole 

selection in the active layer.   

 

 

 

Toggle layout: action to toggle between three layout options of the map view. By 

default, the legend and the overview map are visible in each map view. With the toggle 

layout tool, the user can select between three options: 

- Legend and overview map visible (default) 

- No legend and no overview map visible 

- Only legend visible, no overview map 

The tool presents a picture of the layout that will be presented if the tool is activated. 

The default tool shows an empty layout of the view area. If the tool is activated no 

legend and no overview map will be presented. The tool itself is now changed to the 

following picture: 

 

 

It shows a legend area in the right part of the view area. If the tool is now activated, 

a legend is presented but no overview map. The tool is again changed to the following 

picture:         

 

It now shows both a legend area and an overview map area. If the tool is now 

activated, a legend and an overview map are presented (the default status of the map 

view). The tool is changed to its original picture. 

 

 

Toggle palette: action to toggle between three options of showing/hiding palette 

information the legend. By default, palette information is presented in the legend if 

the number of entries in the palette is less or equal than 32. 

With the toggle palette tool, the user can select between three options: 

- show palette information for each layer with palette information in the legend 

- show palette information for the active layer with palette information in the 

legend 

- show no palette information for each layer in the legend 

Activate the button to select the next option. The picture of this button will not change. 
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Toggle Needle Controller: action to toggle between showing and hiding a horizontal 

and vertical grid line, called a needle controller, in the map view. These grid lines can 

be used for accurate navigation (X and Y coordinates are always visualized in the 

toolbar).  

 

 

 

Toggle Scale bar: Action to toggle between showing and hiding a scale bar in the 

bottom right corner of the map view.  

 

 

 

Copy visible area: action to copy the visible contents of the active map view to the 

clipboard. In case the legend is visible, this legend is also copied to the clipboard. The 

legend can be made (in)visible with the Toggle layout button. 

 

 

 

Copy full legend: action to copy the full contents of the legend to the clipboard. The 

size of contents of the clipboard is limited, if the data to be copied exceeds the 

maximum size of the clipboard, an error is generated. 

Export viewport: exports the active viewport to one or a set of bitmaps, using the 

specified export settings. See paragraph 5.4 for information on how to edit these 

settings. All viewports can be exported by using the File > Export Viewports menu 

option. 

 

 

 

Fit to selected features in active layer: action to enlarge or reduce the zoom level 

and pan the area to make the extents of the selected features in the active layer fit in 

the active map view. 

 

 

 

Select individual feature: a select tool to select individual features in the active 

layer. A ball pen is presented, with which individual features can be selected (left 

mouse click).  

 

 

 

Select rectangle: a select tool to select features with a rectangle in the active layer. 

A ball pen is presented, with which features can be selected. Move the cursor to the 

top left corner of the requested rectangle and press the left mouse button. Keep the 

button pressed and move the mouse to the bottom right corner, a rectangle is drawn 

on the map. Release the mouse button, all features in this rectangle are now selected.  
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Select circle: a select tool to select features with a circle in the active layer. A ball 

pen is presented, with which features can be selected. Move the cursor to the center 

point of the requested circle and press the left mouse button. Keep the button pressed 

and move the mouse to the requested size, a circle is drawn on the map. Release the 

mouse button, all features in this circle are now selected.  

 

 

 

Select free area: a select tool to select features with a user-drawn area in the active 

layer. A ball pen is presented, with which features can be selected. Move the cursor to 

the first point of the requested area and press the left mouse button. Move the cursor 

to the next point and press again. Continue these steps until the complete area is 

drawn. Double click on the last point to select the features in this user drawn area. 

 

 

   

Select contiguous regions: a select tool to select features within a contiguous 

region.  

 

 

 

Select all: action to select all features in the active layer. Activate the tool to select 

all features in this layer.  

 

 

 

Select none: action to deselect all features in the active layer. Activate the tool to 

deselect all features in this layer.  

 

 

 

Show only selected: action to toggle between showing only the selected records or 

showing all records in the map view. In case all records are shown, the selected records 

ale colored in the selection color. In case only the selected records are shown, the 

background color of the layer in the legend becomes the selection color. 
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7.5 Legend 

The legend of the map view has two functions. The first function is the legend function 

for a map, explaining which layers occur in the map including their values units and, 

if applicable, their classifications schemes. The second function is to activate layer 

specific functionality of the layers in the map view. 

 

An example of a legend for a map view is presented in figure 7.5: 

 

 
Figure 7.5: Map view legend with an overview and two layers 

 

The upper part of the legend presents an overview map with the full extent of the 

contents of the configured default layer(s). See the modeler’s guide for how to 

configure a default layer. The purple transparent area indicates the visible part in the 

map view. The overview is used for a geographic reference, but can also be used for 

navigating by dragging the purple area. The overview window is default visible but can 

be made invisible with the pop-up menu from this Legend (see 7.5.1 pop up menu). 

 

All layers in the map view are presented in the legend. The sequence indicates the 

drawing order. The layer at the bottom is drawn first, the following layers are drawn 

next, so the layer at the top of the legend is drawn above all layers. 

 

Each layer in the legend is presented with a title (the name of the data item that was 

requested, or in case this item has a label property configured, its label). Below the 

title, the values unit of the data item is shown. If the information tool is used, the 
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value for the specific object selected in the active layer in the map is also presented 

in this line. 

  

For layers with a classification scheme configured, the palette colors, classes, labels 

and a count of the number of entries in the class are default shown in the legend 

control, in case the number of entries is less than 15. If symbols are defined in the 

scheme, these symbols are also presented. With the pop-up menu (see 7.5.1.) the 

user can hide or visualize this palette information for the layer in the legend.  

 

With the button, the palette information can be shown for no, the active, or for 

all layers. The width of each column can be adapted. Click with the left mouse button 

on the line between the columns, keep the mouse down (a different cursor appears) 

and drag the width of each column to the requested size. 

 

The colors, labels and class values of calculation schemes can be edited from the 

legend. To edit a color, double-click on the color in the legend for a Windows color 

dialogue. To edit the class values or labels, click on the specific cell in the legend. Type 

a new value or use the F2 key to edit the current value. To edit other aspects of the 

scheme, like the number of classes, use the Edit Palette pop up menu option for the 

palette dialogue (see chapter 10).  

 

A layer in the map view and related in the legend has a visible or hidden state. If a 

layer is hidden in the map view, this is shown in the legend with a grey color. The user 

can toggle between the hidden and visible state by double-clicking on the layer title. 

By default, a layer is always visible. 

 

With the Ctrl key pressed and the arrows up and down and left and right, it is possible 

to scroll in the legend. The Ctrl-Home and Ctrl-End key combinations move directly to 

the top and end of the legend. Scrolling becomes relevant if the legend information 

does not fit in the visible area of the screen.  

 

Layer-specific functions and some general map settings can be activated from a pop-

up menu, which is shown if a user clicks with the right mouse button on the layer in 

the legend. The options presented are described in subparagraph 7.5.1. 

 

7.5.1. Pop up menu 

 

Activating the pop-up menu on a layer presents the following menu: 

 
Figure 7.6: pop up menu 
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The following options are available 

- Hide LayerControl for layer 

The layer is not visualized in the layer control (e.g. background layers can be 

made hidden when exporting a legend). A right mouse click on the layer control 

on an empty area offers the option to make the hidden layers visible again. 

- Set LayerControl Font: 

Three options are available for the size of the layer font in the legend. The 

default option is small. The user can set the font size to medium or large. 

- Bring z-Position of Layer: 

The sequence of layers in the legend corresponds to the drawing order in the 

map view. This order can be changed with the four submenu options. Grid 

layers drawn above other layers are visualized transparently.  

Only the relevant submenu actions are enabled for the user: 

- To Top: The layer will be drawn above all other layers. In the legend, the 

layer is moved to the top. The option is only available in case the layer is 

not yet the top layer in the drawing order.  

- To Bottom: All other layers will be drawn above this layer. In the legend, 

the layer is moved to the bottom. The option is only available in case the 

layer is not yet the last layer in the drawing order.  

- Up: The layer is positioned one step higher in the draw order. In the legend, 

the layer is moved one place higher. The option is only available in case the 

layer is not yet the top layer in the drawing order.  

- Down: The layer is positioned one step lower in the draw order. In the 

legend, the layer is moved one place lower. The option is only available in 

case the layer is not yet the last layer in the drawing order. 

The sequence can also be adapted for dragging and dropping the layer. 

- Remove layer: The layer is removed from the map view. 

 

Based on the type of layer some additional layer specific options are available: 

- Show Statistics on layer: presents a dialogue box with the same statistics as 

presented in the Detail page, Value Info (see 5.5)  

- Classify with: if one or more classifications are available for the data item 

shown as attribute layer, these are presented here. The user can select from 

the relevant classifications. 

- Activate TreeItem of Layer Aspect: for each aspect the thematic data and, 

if used, class breaks and aspect values can be activated. The submenu’s 

present the relevant aspects and items and their parents. With a left mouse 

click, the requested item becomes activated. The dominant ggModel layer has 

only a brush color aspect, so only this Activate option is presented in the 

example. 

- Select SubLayer(s), (not for grid layers); the different style aspects used 

to draw a layer can be activated separately. The style aspects differ for the 

different layers types. Therefore, the set of submenu options differ per layer 

type. A  indicates a style aspect is active (visible). For polygon and point 

layers, labels can be activated with the Select SubLayer >Label > Visible menu 

option.  

- Zoom 1 Grid to 1 Pixel (only for grid layers): The layer is zoomed to the 

level at which each grid cell corresponds to one pixel. This is often the most 

elegant level to present a grid. 

- Show Palette (only in case a palette item is used for visualization):  

This option toggles between showing and hiding the palette and label 

information in the legend of the classification scheme used for the data item. A 

 character before the menu option indicates the information is shown.  
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- Edit Palette 

This option activates the edit classification dialogue (see chapter 10) to edit the 

classification/palette used to draw the layer. 

The Edit classification dialogue presents a table, the table tools (see chapter 8) 

can be used for this table. 

 

The pop-up menu can also be activated by right mouse clicking in the map view. The 

layers visible in the map view are shown and the similar functions are available for 

these layers and for the general map view/legend options.  
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Chapter 8: Table 

8.1 Activating a Table  

The Table presents data items or a set of data items of the same domain unit in a 

Table. All data items can be visualized in Table. The Table is the default view for items 

that cannot be visualized in a geographic view, these items can be: 

- Data items for which the domain unit cannot be georeferenced (parameters 

or other data items for which there is no geographic domain, like the label data 

item of a classification). These items are indicated by an  icon. 

- Containers with data items as subitems (first level subitems). The first data 

item of this container determines the domain unit of the Table, all data items 

that have this same common domain unit are visualized in the grid. These items 

are indicated by an  icon. 

   

As with the map view, a new Table can be activated for a tree item, or the tree item 

can be added to an already opened Table (if this opened view is of the same domain 

unit as the requested data item). The following table shows the possible actions to 

visualize a tree item in a Table and the results of the actions: 

 

Action No active Table 

for the requested 

domain unit 

Active Table with 

same domain unit 

as requested data 

item 

Active Table for 

another domain 

Double click on 

selected tree item 

(only if the Table is 

the default viewer, 

indicated by the  or 

 icon) 

New Table window 

with the requested 

data item or all the 

subitems at the 

first level of the 

found domain.  

Data item or 

subitems at the 

first level with the 

same domain unit 

are added to the 

active grid.  

New Table window 

with the requested 

data item or all the 

subitems at the 

first level of the 

found domain. 

Enter key on selected 

tree item (only if the 

Table is the default 

viewer, indicated by 

the  or  icon) 

New Table window 

with the requested 

data item or all the 

subitems at the 

first level of the 

found domain. 

Data item or 

subitems at the 

first level with the 

same domain unit 

are added to the 

active grid. 

New Table window 

with the requested 

data item or all the 

subitems at the 

first level of the 

found domain. 

Main/pop-up menu 

option Default View 

(only if the Table is 

the default viewer, 

indicated by the  or 

 icon) 

New Table window 

with the requested 

data item or all the 

subitems at the 

first level of the 

found domain. 

Data item or 

subitems at the 

first level with the 

same domain unit 

are added to the 

active grid. 

New Table window 

with the requested 

data item or all the 

subitems at the 

first level of the 

found domain. 

Main/pop-up menu 

option Table View  

New Table window 

with the requested 

data item or all the 

subitems at the 

first level of the 

found domain. 

New Table window 

with the requested 

data item or all the 

subitems at the 

first level of the 

found domain. 

New Table window 

with the requested 

data item or all the 

subitems at the 

first level of the 

found domain. 

Ctrl-D on selected 

tree item 

New Table window 

with the requested 

data item or all the 

subitems at the 

New Table window 

with the requested 

data item or all the 

subitems at the 

New Table window 

with the requested 

data item or all the 

subitems at the 



  User Guide GeoDMS GUI 7.180 

 

 49 

first level of the 

found domain. 

first level of the 

found domain. 

first level of the 

found domain. 

Drag and drop to 

view area/active 

window 

On empty view 

area: New Table 

window with the 

requested data 

item or all the 

subitems at the 

first level of the 

found domain 

Data item or 

subitems at the 

first level with the 

same domain unit 

are added to the 

active grid. 

Another view:  

Not allowed to drop 

the item. 

8.2 Table 

Activating the Table for the tree item: Geography/RegionUnits/Province/VAT results in 

the following table: 

 

 
Figure 8.1: Table View  

 

The mentioned tree item is a domain unit with 13 elements. All subitems have VAT as 

domain unit. Therefore, all these subitems are shown in the table. 

The first column shows the index number(id). The other columns contain the data 

items requested. Some columns are colored a darker grey, indicating their values 

cannot be edited. Columns with values that can be edited are colored light grey. 

 

The width of the columns can be adapted by moving the mouse to the header row (in 

light grey background color with the labels of the presented data item), on the border 

between two columns. Click with the left mouse button, keep this button pressed and 

move the mouse to the left or the right to change the size of the columns. 

The sequence of columns can be adapted with drag and drop on the column header of 

a label. Click with left mouse button on a header, keep the mouse pressed and move 

the mouse to the requested position. 

 

In the table, a cell or a column can get the focus. Click on a cell or a column header 

to set the focus. Also, a focus rectangle can be used to set the focus to multiple cells. 

Therefore, first set the focus to one cell and use the arrow keys to enlarge the focus 

rectangle (colored black). Also in a focus rectangle, there is always one focus cell 

(colored blue).    
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If the Detail page Value Info is active, the whole path of how this selected data value 

in the Table is constructed is shown (see paragraph 5.6). The focus cell in the table is 

related to the information tool in the map view. If information is requested on a feature 

in the map view, the cell of the record of this feature receives the focus and vice versa.  

 

A column receives the focus by a left mouse click on the label of the column in the 

header row. With a right mouse click on the label a pop-up menu for the column is 

activated, with the options: 

- Sort on data item name: To sort values ascending or descending 

- Relative Display: to present the numeric values as percentage of the total 

- Copy data item name: To copy the values of the item to a new data item with 

the name: data item name + Copy + SequenceNr, mainly relevant in 

classifications 

- Remove data item name: to remove the selected column from the Table. 

- Ramp Values: to ramp the values of a distribution, mainly relevant in 

classifications. This option is only available for not derived, numeric data items 

with more than one entry. 

8.3 tools 

If the Table is active, the following tools are available in the toolbar: 

 

 

 

Copy text: Copy the highlighted contents of the table as semicolon delimited text to 

the clipboard. String attributes are quoted. 

 

To highlight a cell, click on the cell with a left mouse click. Use the arrow keys to 

enlarge or diminish the set of highlighted cells. 

 

To copy the whole table: 

1. Highlight only one cell, a single highlighted cell will copy the whole table. 

2. Un-highlight all cells, click with the left mouse click on a highlighted cell and 

press the Escape key. 

 

  

 

Copy image: Copy the visible contents of the active table as an image to the clipboard.  

 

 

 
Save to csv: Save the highlighted contents of the table as semicolon delimited text 

to a file. String attributes are quoted. The path of the file is indicated by a dialog. 

 

 

 
Group by: Group the data by the unique values in the selected column.  

 

 

 

Show first selected row: Action to scroll the table to present the first selected row(s) 

in the visible part of the table. 
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Select focus cell range: Select the records for which cells are part of the cell range 

in the table. The selection will also apply to the map view and vice versa. The selection 

color is light blue. 

 

 

 

Select all: Action to select all rows in the table. The selection will also apply to all map 

views. 

 

 

 

Select none: Action to deselect all rows in the table. The selection will also apply to 

all map views. 

 

 

 

Show only selected records: Action to toggle between showing only the selected 

records or showing all records in the table.  
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Chapter 9: Histogram View 
 

9.1 Histogram view 

A histogram presents a graph with a frequency distribution of the occurring data values 

in a data item. If the data item is not classified (the value type of the values unit is 

not uint8), a classification is needed before a histogram can be made. Only the class 

values are used for the histogram view, not the palette colors or the labels. The 

following example shows the histogram for the data item: 

Current_Situation/Current_landuse/predominant_2010 

 

 
Figure 9.1: Histogram view  

 

The values on the x-axis correspond to the land use classification. The y-axis shows 

the count of the number of occurrences in the domain of the original data item, in this 

case, land use classes. The full name of the presented data item is shown in the graph 

title. 

 

A histogram can be activated with the main or pop-up menu Histogram View (Ctrl H) 

if the tree item is a numeric data item (not a parameter).  
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Chapter 10: Insert Classification and Palette  

10.1 Classifications and palettes 

Classifications are used to classify numeric data items into a set of classes. A 

classification is mainly used in primary data viewers to group relevant sets of elements. 

These groups are visualized using the same visualization style. In the GeoDMS GUI 

themes (colors, sizes, symbols and styles) are used to visualize classes of an attribute 

layer in a map view. The classification and palette editor can for the moment only be 

used to specify colors (other themes need to be configured in the dms configuration 

files, see the modeler’s guide). The set of colors for each class in a classification 

scheme is called a palette. Often also a label is requested for a class in classification 

that, if used, is shown in the legend of a primary data viewer.  

The next table shows where classifications in the GeoDMS GUI are used, depending on 

the requested data item: 

 

Data type Thematic map 

layer 

Histogram Export to 

bitmap 

    

Unclassified one 

dimensional numeric data 

item 

(value type int8, 

(u)int16/32, float32/64) 

Classification: obl 

Palette: obl 

Label: opt  

Classification: 

obl Palette: nu  

Label: nu 

Classification: 

obl Palette: obl 

Label: nu 

    

Classified one dimensional 

numeric data item and 

Boolean 

(value type uint8 and 

Boolean) 

Classification: opt 

Palette: obl 

Label: opt 

Classification: 

opt Palette: nu 

Label: nu 

Classification: 

opt Palette: obl 

Label: opt 

    

Non numeric data item 

(value type = string) 

Classification: np 

Palette: np 

Label: np 

Classification: 

np Palette: np 

Label: np 

Classification: 

np Palette: np 

Label: np 

    

Point, arc and polygon 

data (value types 

(s)(d)(f)(i) 

point/arc/polygon) 

Classification: np 

Palette: np 

Label: np 

Classification: 

np Palette: np 

Label: np 

Classification: 

np Palette: np 

Label: np 

 

obl: obligatory 

opt: optional 

nu: not used 

np: not possible  

  

Classifications and palettes in the GeoDMS can be configured for both data items as 

well as units. If a classification or palette is needed for the requested user action (as 

presented in the table), the GeoDMS GUI first checks for the requested data item if 

these are available. If not, the GeoDMS GUI checks for the values unit of the requested 

data item if a classification and palette is configured. In case no classification and/or 

palette is found for both data item and values unit, a default classification is generated.  
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Classifications including palettes and labels can be inserted or edited with the 

Insert/Edit Classification and Palette dialogue. Select the data item or unit for which a 

classification needs to be configured and activate the Insert Classification and Palette 

main or pop-up menu option (or the Ctrl F keyboard combination). Use the Edit 

Classification and Palette main or pop-up menu option (or the Ctrl + Alt + C keyboard 

combination) to edit the classification and palette of a data item or unit. Be aware, if 

a data item has no classification configured, the Edit Classification and Palette option 

edits the classification configured for the values unit.      

 

10.2 Insert Classification and Palette dialog 

 

The editor can e.g. be activated from the legend in the map view. Activate a map view 

for the item: /Current_Situation/Current_landuse/LU_2010/residential 

Activate the palette editor with the Edit Palette pop up menu option for this layer, the 

following view appears: 

 

 
Figure 10.1: PaletteEditor for /Current_Situation/Current_landuse/LU_2010/residential 

 

 

This view with the classification scheme contains a Table, as described in chapter 8. 

The table tools can be used for this table. This Table contains a Brush color, label, 

classes and count column. The count column is grey, indicating its values cannot be 

edited. The sequence of the columns and the width can be adapted as described in 

paragraph 8.2.  

 

Classes are always increasing and connected. In the table, the start value of each class 

is presented. The end value is the start value of the next classes, presented in the 

next row. The last class is always infinite. 

 

The pop-up menu of the table view with some different options is available for the 

columns of the Table. See the column description for their specific menu options. 
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BrushColor: individual colors can be edited by double-clicking on a specific color cell. 

A Windows color dialogue appears. The pop-up menu option for this column contains 

the following options: 

 

 
 

- Copy BrushColor: to copy the color column to a new color data item, with the 

name of the original item, the extension Copy and a sequence number. This 

way color columns that cannot be edited (e.g. because read from an ODBC 

source) can be copied, the copy item can be edited.  

- Remove BrushColor: to remove the column from the view 

- Ramp Colors: multiple color cells can be selected to ramp the colors. Select a 

start and end color for the ramp, and activate this menu option. The ramp can 

be made for all classes or a random selection of at least two consecutive 

classes. 

- Change Color: Select a color from a palette editor or set the color to fully 

transparent 

- Classify original data item: to classify the original data item, see the class’s 

column. 

- Copy Table class unit: to copy the whole classification scheme. 

 

Label: individual labels can be edited by activating the cell and typing a new label or 

by pressing the F2 function key and editing the current label. The pop-up menu option 

for this column contains the following options: 

 

- Copy Label: to copy the label column to a new color data item, with the name 

of the original item, the extension Copy and a sequence number. This way label 

columns that cannot be edited (e.g. because read from an ODBC source) can 

be copied, the copy item can be edited. 

- Remove Label: to remove the column from the view 

- Classify original data item: to classify the original data item, see the class’s 

column. 

- ReLabel: to relabel the contents of the label column with derived labels from 

the class boundaries 

- Copy Table class unit: to copy the whole classification scheme. 
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Classes: individual classes can be edited by activating the cell and typing a new class 

value or by pressing the F2 function key and editing the current class value. The pop-

up menu option for this column contains the following options: 

 
 

- Relative Display: to present the values as % of the total  

- Copy Classes: to copy the classes column to a new color data item, with the 

name of the original item, the extension Copy and a sequence number. This 

way class columns that cannot be edited (e.g. because read from an ODBC 

source) can be copied, the copy item can be edited. 

- Remove Classes: to remove the column from the view 

- Ramp Values: with this option, the class values can be ramped, like the colors. 

If the whole column is activated, this options functions like the equal interval 

classification (see the next option) only based on the first and last value of the 

class breaks, where the equal interval is based on the min and max value of 

the thematic attribute.   

- Classify original data item. This option is used to classify the original data 

item. First, specify the number of requested classes in the #class’s text box. 

Next, select one of the four types of classifications that are available: 

- Unique values (available for all data items with a number of unique 

occurrences that fits in the range of the domain unit): a class is added for 

each value that occurs in the data item. The number of classes is based on 

the number of unique occurrences. The maximum number of classes is 

dependent on the domain unit of the class unit.  

- Equal counts (available for all data items): the occurring data items are split 

up into classes with, as far as possible, an equal count of occurrences in 

each class. The class breaks are first set to the number of sorted data 

elements (excluding the no data values) divided by the number of requested 

classes. Each class break is checked to determine whether the next data 

element has the same value as the data element at the break. If this is the 

case, the class break is increased to the next data element, until a data 

element is found with a new value. If this data element is not found before 

the next class break, the last class break is removed and the number of 

classes is decreased by one class 

- Equal intervals (available for all items): the range of the data in a data item, 

or the specified range of a values unit, is split up in intervals of the same 

size. If no range is specified the default range for the value type of the unit 

is used.  

- JenksFisher (natural breaks): applies the JenksFisher classification method 

to minimize the variance within each class. 

- Logarithmic intervals (available for all items with a minimum value of zero): 

the range of the data in a data item or the specified range of a values unit 

is split up in intervals of the same size using a logarithmic distribution. If 

no range is specified the default range for the value type of the unit is used. 

- Copy Table class unit: to copy the whole classification scheme.  

http://wiki.objectvision.nl/index.php/Fisher%27s_Natural_Breaks_Classification
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PART III COMPOSERS 
The feature of composing scripts for the GUI is now under consideration to be 

discontinued. 

Introduction: 
Composers are used to add or edit the configuration for a project. To use composers, 

the GeoDMS needs to run in the administrator mode. See paragraph 4.2.5, options 

menu, for how to run the GeoDMS in this mode. 

Chapter 11: Insert Container 

11.1 Containers 

Containers in the GeoDMS are used to group subitems. They can be compared to the 

folders on a hard disk. A container is not a data item but can have an expression, if 

the container represents a case. The expression for a case consists of the calculation 

scheme with the set of selected parameter values. The Insert Container dialogue is 

mainly used for containers without expressions. 

 

Select the tree item in which the container needs to be added as a subitem. Activate 

the main or pop-up menu option Insert Container (or the Ctrl-R keyboard 

combination). The Insert Container dialogue is presented: 

 

11.2 Insert Container dialogue 

  
Figure 11.1 Insert Container dialogue 

 

In this dialogue the following properties of a new container can be specified: 

 

Name (obligatory): the name of the container as shown in the Treeview. The following 

rules apply to a tree item name: 

- only letters, numbers and underscores are allowed characters  
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- the first character may not be an underscore or a number   

 

Label (optional): the label of the container that is presented in the primary data 

viewers and the property Detail Pages. 

  

Description (optional): a more extensive description of the container, shown e.g. as 

a tooltip or in the property Detail Pages. 

 

If the name of the container is specified, the Create button property becomes enabled. 

Click the button to add the container. The container is added with a   icon, as it has 

no subitems yet. If subitems are added (and the Treeview is updated) the container 

will be presented with a   icon (if the container has no data items as subitems) or 

with a  icon. 

 

Chapter 12: Insert Data Item 
 

This functionality is in maintenance.  
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Chapter 13: Insert Entity/Unit  
 

13.1 Values and domain units 

All data items in the Geo DMS are defined by a name, a domain and a values unit. The 

domain unit determines to which collection a data item refers, e.g. municipalities in 

the Netherlands. Conceptually the domain unit is also called an entity, in database 

terms often implemented as a table. The domain unit determines if a data item can be 

geo-referenced and presented in a map view. Furthermore, it is an important 

consistency check in modelling, as for most operators it is not sensible to combine 

data items of multiple domains (e.g. it is not sensible to sum a data item NrInwoners 

per municipality with another NrInwoners data item per country). The Geo DMS checks 

this kind of inconstancies when an expression is made or edited.     

 

A values unit describes how to interpret the values in terms of their value type (e.g. 

uint8, float32 or string) and their metric unit (the scientifically known unit, e.g. meter, 

second, 100 * kilogram etc.). Both the value type and the metric unit are important in 

modelling with data items. Data items with a values unit of a different value type can 

often not be combined in expressions unless the items are explicitly changed to 

another value type. The reason is that the result of an expression in which, for 

example, integers and floating point value units are combined is not defined in terms 

of their value type (for a complete list of the value types see the modeler’s guide or 

the website: www.objectvision.nl/GeoDMS ). For the metric unit, it depends on the 

operator if values units of different metric units can be combined in an expression. The 

sum of a data item with a metric unit of meters and another data item with a metric 

unit of seconds is not sensible. But the division of these items can be sensible, resulting 

in a data item that indicates the speed with a metric unit of a meter per second. The 

value type and the metric unit are also checked when an expression is inserted or 

edited. 

 

13.2 Insert Entity/Unit dialogue 

With the Insert Entity/Unit dialogue, new units can be added to the configuration. The 

unit is added as a subitem of the selected tree item from which the Insert Entity/Unit 

dialogue was activated. It is advisable to select the unit’s container first and activate 

the dialogue with this tree item selected (unless a unit at another location in the tree 

is requested). The dialogue can be opened with the main or pop-up menu option: 

Insert Entity/Unit or with the Ctrl E keyboard combination. The following dialogue is 

presented: 
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Figure 13.1: Selection of the unit type in Insert Entity/Unit dialogue 

 

With this dialogue, two types of domain units and seven types of values units can be 

configured. If a unit type is chosen a short description of the unit type is presented in 

blue text color at the right side of the dialogue. Click the Next button to configure the 

requested unit type.  

 

For each unit type the following three properties can be configured: 

 

Name (obligatory): the name of the unit as shown in the Treeview. The following rules 

apply to a tree item name: 

- only letters, numbers and underscores are allowed characters  

- the first character may not be an underscore or number   

 

Label (optional): the label of the unit that is presented in the primary data viewers, 

e.g. in the legend of the map view and in the Properties Detail Pages. In labels, all 

characters are allowed. 

   

Description (optional) a more extensive description of the unit, (e.g. as a tooltip or 

in the Property Detail Pages). In descriptions, all characters are allowed.  
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13.3 Table unit 

A Table unit is used to configure an entity with one-dimensional data items. In 

database terms this is often implemented in a table, resulting in the name table unit. 

The following dialogue is presented for this unit type:  

 

 
Figure 13.2: Insert Table unit dialogue 

 

Within the GeoDMS GUI 7.163 a new table unit can be configured in five different 

ways: 

- Base unit: A new table unit is requested that cannot be derived from other 

domain units. Activate the Base unit option, select a value type (uint32, uint16 

or unit8 for table units) and a count (the number of elements of the table unit). 

Both elements need to be configured before the OK button becomes enabled 

and the unit can be added. Click the OK button to add the new domain unit. 

- Subset: This option creates a new domain unit, based upon a selection of 

another domain unit (source table unit). Activate the Subset option, select the 

source table unit and a filter attribute by activating the  button next to the 

text box. A dialogue is activated to select a tree item (see paragraph 13.3.1 for 

a description of this dialogue). The filter attributes presented are all Boolean 

attributes with the selected source table unit as domain unit. If no suitable filter 
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attribute is configured, a filter attribute needs to be created first with the Insert 

Data item dialogue (see chapter 12). Click the OK button to add the new domain 

unit. 

- Combine: This option creates a new domain unit with the Cartesian product of 

a set of source table units (with a maximum of 8 source table units). This implies 

for each combination in the original table units a new entry is made in the new 

domain unit. Assume we have two table units, one with 600 municipalities and 

another with 10 years. The combined option results in a new domain unit with 

an entry for each municipality for each year, resulting in a new domain unit with 

6.000 elements. To configure such a new domain unit, activate the combine 

option and select from the available units the source domain units that need to 

be combined with the arrow buttons: 

  Move all items from the available list to the selected list 

 Move the selected items from the available list to the selected list   

 Remove the selected items from the selected list 

 Remove all items from the selected list 

 

Click the OK button to add the new domain unit. 

- Unique: This option creates a new domain unit with the distinct, sorted values 

of an attribute of a source table unit (e.g. municipality codes in a source domain 

unit of neighborhoods). The unique operator can be compared to the distinct 

operator in a SQL statement. To make a new table unit of these unique 

occurrences, activate the unique option. Next, select the source table unit and 

the filter attribute by activating the  button. The filter attributes, presented 

are all attributes having the selected source table unit as domain unit. Usually, 

code attributes are relevant as a filter for this type of unit. The checkbox “create 

count item” can be optionally selected. This will result in a new attribute for the 

new domain unit with the number of occurrences of the filter attribute in the 

original domain. Click the OK button to add the new domain unit. 

- Union: This option adds multiple domains together (e.g. domain units of cities 

in Netherlands, Belgium and Luxembourg are combined to a new domain unit, 

cities in the Benelux). To create a new domain unit with the union operator, 

attributes in the original domains need to be chosen that have the same values 

unit and can be united in the new domain. First, select a target values unit. For 

a selected values unit, the available attributes (with their domain units) are 

presented in the available list. Select the attributes that need to be united, with 

the arrow buttons (with a maximum of five): 

  Move all items from the available list to the selected list 

 Move the selected items from the available list to the selected list   

 Remove the selected items from the selected list 

 Remove all items from the selected list 

 

Click the OK button to add the new domain unit.  

 

13.3.1 TreeItem selection dialogue 

In the Insert Entity/Unit dialogue at multiple places, a tree item needs to be selected. 

A generic dialogue is used in which the number and content of the columns can differ, 

based on the relevant information for the selection. The functionality of the dialogue 
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is similar. An example of the dialogue to select a source table unit for the subset option 

is described in Figure 13.3. 

 

 
Figure 13.3: Tree item selection dialogue 

 

In the dialogue, tree items can be sorted on each column by clicking the header of the 

column once (ascending) or twice (descending). Also, a filter can be applied by clicking 

the right mouse button on the header of the column and activating the pop-up menu 

option: Set filter. In a text box, a complete name or part of a name can be specified. 

The filter option is case insensitive. Activate the option again, leave the text box blank 

and click OK to remove the filter. This described dialogue is used for all locations where 

a tree item needs to be selected. 

 

13.4 Grid unit 

A Grid unit is used to configure an entity with two-dimensional data items, data items 

for which the domain is a grid or a matrix with an X and a Y coordinate. The following 

dialogue is used to configure a new grid unit:   
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Figure 13.4: Insert Grid unit dialogue 

 

A grid unit can be configured as a base unit or derived from another configured grid 

unit. Activate the base unit option to create a new grid domain that cannot be related 

to the existing grid unit. For a base unit the coordinate of the top left position and 

bottom right position need to be specified, to derive the range of the grid domain (e.g. 

the coordinate of the top left position of a rdc_500-meter grid unit is (0, 0) and the 

coordinate of the bottom right position is (650, 560)). Both coordinates need to be 

configured before the Ok button becomes enabled and the unit can be inserted. 

 

If a grid unit is derived from another grid unit, activate the gridset unit option. Select 

the reference unit from which the new grid unit will be derived. The rdc_500 unit is 

e.g. a derived unit from rdc_meter. For derived units, additional to the top left and 

bottom right coordinate (as described for base units), a scale factor and a relation 

between the (0,0) coordinate of the new and the referred grid is necessary. The scale 

factor in both x and y directions specifies how 1 length unit in the referred grid needs 

to be interpreted in the new grid. The (0,0) coordinate specifies how the (0,0) position 

in the referred grid relates to the (0,0) position in the new grid. All these factors and 

coordinates need to be specified before the Ok button becomes enabled and the unit 

can be inserted. 
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13.5 Quantity unit 

A quantity unit is used as values unit for numeric, non-geographic, data, describing a 

quantitative characteristic like distance in meters or land use in hectares. The following 

dialogue is used to configure a new quantity unit:     

 

 
Figure 13.5: Insert Quantity unit dialogue  

 

A quantity unit can be a new base unit (if the unit cannot be derived from another 

base unit) or a derived unit. If a quantity unit can be derived from another unit (for 

example square meter can be derived from an existing unit meter, with the expression 

meter * meter) it is advised to configure a derived unit, instead of a new base unit. If 

in the example square meter is defined as a derived unit with the expression meter * 

meter, the GeoDMS recognizes that square meters are a valid values unit for the 

multiplication of two data items with values units meters. If square meter was 

configured as a new base unit, this knowledge was not known to the Geo DMS. 

Configuring square meters as values unit of the result of a multiplication of two data 

items in meters would then result in an error. 
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If a new base unit is requested, activate the base unit option. Except for the name, 

label and description, only a value type needs to be selected. For quantity units, this 

is always float32 or float64. Click the OK button to add the configured unit.  

If a new derived unit is requested, active the derived unit option. The check button 

 next to the expression box becomes enabled. An expression on how to derive the 

unit from existing units and constants need to be configured. For example, a new unit 

for cubic meters (m3) is requested. Type the expression Meter2 * Meter (or, Meter * 

Meter * Meter) in the Expression box. The full name of the tree items (Units/Meter) is 

not needed when the new unit is configured within the unit container. Activate the 

check button to check the syntax of the expression. If is it a valid expression, the 

check label on the button becomes green and the unit can be inserted. If it is not a 

valid expression, the label becomes red and an error is generated.     

 

13.6 Point unit 

A point unit is used as values unit for geographic data items that contain coordinates, 

e.g. in grids or in point shapes files. The following dialogue is used to configure a new 

point unit:   

   

 
Figure 13.6: Insert Point unit dialogue  
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The value type of the point unit needs to be selected (for a complete list of the value 

types see the modeler’s guide or the website: www.objectvision.nl/GeoDMS). The 

coordinate of the top left position and bottom right position can be specified, in order 

to derive the range of the point units, but unlike the grid domain for a point unit, this 

is optional. Activate the OK button to insert the unit. 

 

13.7 Shape unit 

A shape unit is used as values unit for geographic data items that contain sets of 

coordinates, e.g. in arc or polygon Shapefiles. The following dialogue is used to 

configure a new point shape unit:  

 

 
Figure 13.7: Insert Shape unit dialogue 

 

The value type for the shape unit (fpoint or dpoint, see the modeler’s guide or the 

website: www.objectvision.nl/GeoDMS, ipoint or spoint units cannot yet be configured 

with this dialogue) needs to be selected. The coordinate of the top left position and 

bottom right position can be specified, to derive the range of the shape unit (optional). 
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The format (polygon or arc) also need be specified. Activate the OK button to add the 

unit. 

13.8 Code unit 

A code unit is used as values unit for numeric data items that refer to codes/classes, 

e.g. municipality codes. A code unit has no expression and metric. The following 

dialogue is used to configure a new code unit:       

 

 
Figure 13.8: Insert Code unit dialogue 

 

The value type for the code unit needs to be selected. For code units, the potential 

value types are all integer types and string units. The range of the unit can be 

configured (if known this is recommended and used by the Insert Classifications and 

Palette dialogue). Activate the OK button to insert the unit. 

 

13.9 String unit 

String units are used for data items that contain alphanumeric characters, e.g. 

municipality names. These data items are mainly used as labels. Except for the name, 
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label and description, no other information is required. Activate the OK button to insert 

the unit. 

 

13.10 Boolean unit 

Boolean units are used for data items that represent yes or no values. Except for the 

name, label and description, no other information is required. Activate the OK button 

to insert the unit. 

 

13.11 Focal point matrix 

The focal point matrix unit is a specific unit for potential calculations. The following 

dialogue is used to configure a new focal point matrix:       

 

 
Figure 13.9: Insert Focal point matrix dialogue 

 

With this dialogue, a new spoint unit is created, with tree subitems for DistMatrX, 

AbsWeight and RelWeight. The specified distance (obligatory) determines the range of 

the new spoint unit. The value type of the subitems also needs to be specified in the 

combo box: Subitems type. Activate the OK button to insert the unit.  
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Chapter 14: Expression dialogue 

14.1 Expressions 

The model logic in the Geo DMS is implemented by configuring expressions for tree 

items. An expression is a calculation rule combining operators, data items and 

constants. In the default configuration, expressions are set to a number or tree items. 

Expressions can be edited or new expressions can be set with the Expression dialogue.  

 

Select a tree item and activate the main or pop-up menu option Edit Definition (or the 

Ctrl-Alt-E keyboard combination). The Expression Dialog is presented. If the item has 

an expression configured, this is shown in the dialogue. 

14.2 Expression dialogue 

The following example shows the dialogue for the tree item: The following example 

shows the dialogue for the tree item: RegioIndelingen/Gemeente/Corop_rel  

 

Figure 14.1 Expression dialogue  

 

The expression dialogue consists of two parts. In the Expression box, the expression 

is shown. The Dependencies box at the bottom shows the dependencies (tree items 

with their full names) derived from the expression.   

  

Tree items can be dragged into the Expression box from the Treeview and from the 

dependencies box. They can also be typed, but by using drag and drop typing errors 

in tree item names are expelled. Constants can be typed in the Expression box. 

 

The contents of the expression dialogue can be copied to the Window clipboard by 

selecting the text (keep the left mouse button pressed, while moving over the text), 

clicking the right mouse button over the pop-up menu and choosing the copy option. 

The main menu option Edit Copy or the Control C keyboard combination cannot be 

used for this purpose, as they only apply to copying tree items.  
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14.3 Tools 

If an expression dialogue is activated, the set of specific expression dialogue buttons 

is presented in the toolbar. The following buttons are available:  

 

 
Clear expression: Button becomes enabled if an expression dialogue is not empty. 

Activate the button to remove the whole expression and clear the expression box. 

 

 
Apply changes: Button becomes enabled if the configured expression is edited or a 

new expression is configured for the selected tree item. The apply changes tool first 

checks the syntax. If this is correct the new expression is stored in the tree item. If 

errors occur they are presented to the user.   

 

 
Reset original expression: Button becomes enabled if the configured expression is 

edited or a new expression is configured for the selected tree item. The reset original 

expression resets the expression box to the original configured expression of the tree 

item selected when the dialogue was activated. 

 

 
Syntax check: This button is used to check the syntax of the expression for following 

topics: 

- Correct  number of arguments for the operators 

- Correct type of the arguments (e.g. a unit cannot be summed with a data item) 

- Known tree items (e.g. a tree item with an incorrect name cannot be found) 

- Correct domain and values units in calculations. Depending on the operators, 

combining items with a different domain and values units can cause errors.   

 

The √ sign on the button can appear in four different colors: 

Grey: no expression is configured, so the expression cannot be checked 

(disabled state). 

Black: an expression is configured but not yet checked for a valid syntax. 

Green: an expression is configured, checked and the syntax is correct. 

Red: an expression is configured, checked but an error occurred in the syntax. 

 

 
Update check: This button is used to check if the data item can really be updated. 

The syntax needs to be valid, but this does not guarantee the data item can be 

updated. (e.g. the file from which the primary data should be read is absent, or 

corrupt, or the data could cause divisions by zeroes, etc.). To be sure the data item 

can be updated, the update check can be activated, although this can take some time 

as it actually updates the tree item. 
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The  sign on the button can appear in four different colors: 

Grey: no expression is configured, so the expression cannot be checked 

(disabled state). 

Black: an expression is configured but not yet checked for an update. 

Green: an expression is configured, checked and can be updated. 

Red: an expression is configured, checked but an error did occur while updating  
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Chapter 15: Import/Export primary data  
 

15.1 Introduction 

Data items in the Geo DMS refer to primary data that can be stored in different 

formats. For some data items, with a limited amount of data, the primary data is stored 

in the configuration, like parameters and classifications. But for most data items the 

primary data is stored in external files. The Geo DMS reads the external files when the 

data is requested for viewing or calculating. In the configuration is specified which 

external data sources are used. The data does not explicitly have to be imported but 

is linked via the configuration. The external data formats that can be used within the 

GeoDMS are described here. 

 

The configuration of data items linking to some external data formats can be performed 

with composers. Use the Insert External Datalink main or pop up menu option on a 

selected item that is requested as a parent for the configured of a new data source. 

The dialogues to configure new source data are described in paragraph 15.2 

 

Most data items configured in the Geo DMS can be exported. This applies to both 

source data as well as model results. Based on the data item, the data can be exported 

to the following formats: 

- Ascii grid 

- Bitmap/Tiff 

- Ascii attribute    

 

Exporting data is an action, not resulting in a new (set of) tree item(s). The export 

option can be activated from the main File > Export primary data menu option or from 

the pop-up menu Export primary data, from which in a submenu a format needs to be 

selected. In paragraph 15.3 the different export formats and their dialogues are 

described. 

 

15.2 Linking primary data 

Data stored in an ASCII grid, shape, ODBC or DBF format can be configured with the 

GeoDMS GUI. Activate the Insert External Datalink menu option for the requested data 

format on the selected tree item that will be used as a parent for the configured ASCII 

grid. The following dialogues appear: 

 

http://www.objectvision.nl/geodms/modellers-guide/4-data-sources


  User Guide GeoDMS GUI 7.180 

 

 74 

15.2.1 ASCII grid 

 

 
Figure 15.1: Insert External Datalink, ASCII grid dialogue 

 

In this dialogue the following options can be configured: 

 

Name (obligatory): the name of the container to which the ASCII grid file is 

configured, with subitems for the data in the grid (Griddata) and four parameters 

describing the ASCII grid (xllcorner, yllcorner, cell size and NODATA_val). The 

following rules apply to a tree item name: 

- only letters, numbers and underscores are allowed characters  

- the first character may not be an underscore or number 

It is advised to first select an ASCII grid file with the  button, next to the ASCII 

grid textbox. If an ASCII grid file is selected, the name of the tree item default receives 

the name of the ASCII grid without the file extension. 

 

Label (optional): the label of the container that is presented in the Detail Pages. In 

labels, all characters are allowed. 

   

Description (optional): a more extensive description of the container, (e.g. as a 

tooltip or in the Property Detail Pages). In descriptions, all characters are allowed. 

 

ASCII grid (obligatory): the selected ASCII grid file, use the  button to activate a 

Windows file dialogue for the selection of an ASCII grid file. It is advised to start the 

dialogue with this selection, as the tree item name is derived from and the options for 
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the domain unit are depending on the selected ASCII grid file. The full path name is 

shown for a selected ASCII grid file. 

 

Domain unit (obligatory): the grid domain unit, used as domain unit for the new 

ASCII grid. First, an ASCII grid file needs to be selected. The selection button  

becomes enabled and can be activated to select a grid domain unit that fits the selected 

ASCII grid file. A grid domain unit fits if its number of rows and columns (specified by 

the range) equals the specified number of rows and columns in the ASCII grid. The 

dialogue used to select a domain unit is described in paragraph 13.3.1. If no suitable 

domain unit is found, a new domain unit (grid unit for ASCII grids) can be configured 

from the selection dialogue with the New button (See chapter 15 for how to configure 

a new grid unit). 

 

Values unit (obligatory): the values in the ASCII grid need to be defined in terms of 

their values unit. For this reason, select a values unit with the selection/button. The 

dialogue used to select a values unit is described in paragraph 13.3.1. All numeric non-

geographic values units, configured in the unit containers (as specified in the 

config.ini), are shown and can be selected. 

 

Configure attribute of ASCII grid (optional): If an ASCII grid is fully configured, 

this option becomes enabled. In case a base grid is available, a selection can be made 

for the relevant values in an ASCII grid. This selection of values can be configured as 

an attribute, by activating the configure attribute of ASCII grid option. Activating the 

option enables the selection/button next to the Data item textbox. A base grid data 

item needs to be selected. With the extra option, an additional attribute is configured. 

This attribute has the same values unit as the grid data and the same domain unit as 

the base grid and contains the values from the relevant ASCII grid according to the 

values in the base grid.      

 

By activating the OK button, the ASCII grid configuration is completed. 
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15.2.2 dBase (versions III, IV or V): 

 

 
Figure 15.2: Insert External Datalink, dBase dialog 

 

With this dialogue the following options can be configured: 

 

Name (obligatory): the name of the container to which the dBase file is configured, 

with subitems for the configured attributes. The following rules apply to a tree item 

name: 

- only letters, numbers and underscores are allowed characters  

- the first character may not be an underscore or number 

It is advised to first select a dBase file with the  button, next to the dBase textbox. 

If a dBase file is selected, the name of the tree item default receives the name of the 

dBase file without the file extension. 

 

Label (optional): the label of the container that is presented in the Detail Pages. In 

labels, all characters are allowed. 

   

Description (optional) a more extensive description of the container, e.g. as a tooltip 

or in the Property Detail Pages). In descriptions, all characters are allowed. 
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dBase file (obligatory): the selected dBase file, use the  button to open a Windows 

file dialogue for the select a dBase file. It is advised to start this dialogue with this 

selection, as the tree item name is derived from and the options for the domain units 

are depending on the selected dBase file. The full path name is shown for a selected 

dBase file. 

 

Domain unit (obligatory): the domain unit (table unit) for the dBase file (a dBase file 

always contains one table). First, a dBase file needs to be selected. The selection 

button  becomes enabled and can be activated to select a domain unit that fits the 

selected dBase file. A domain unit fits if its number of elements equals the number of 

records in the dBase file. The dialogue used to select a domain unit is described in 

paragraph 13.3.1. If no suitable domain unit is found, a new domain unit (table unit 

for dBase files) can be configured from the selection dialogue with the New button 

(See chapter 15 for how to configure a new table unit). 

 

Data in a dBase file is stored in one or multiple attributes. If a dBase file is selected, 

all attributes of this file (except for the date and memo attributes) are shown in the 

Available attributes box (including their value type). With the  button, a selected 

attribute can be configured. The selection dialogue to select a values unit (this dialogue 

is described in paragraph 13.3.1) is activated. For each attribute to be configured a 

values unit must be selected. All non-geographic values units, configured in the unit 

containers (as specified in the config.ini), are shown and can be selected. After 

selecting a values unit, the attribute is added to the box of Configured attributes. If 

a wrong attribute is configured, or an attribute is configured with an incorrect values 

unit, it can be removed from the list of configured attributes with the  button. 

 

In the list of configured attributes can be specified if an attribute can be used as 

primary key. For dBase files sec, this is not used in the configuration. If the dBase file 

is part of a Shapefile configuration, it is needed to specify the primary key in the 

accompanying dBase file (see 15.2.4 Shape file configuration). The property if an 

attribute can be used as primary key for the table can be activated with a pop-up menu 

(right mouse click) and the option: Set as key. 

  

By activating the OK button, the dBase configuration is completed. 

 

15.2.3 ODBC source 

This functionality is in maintenance. 

 

15.2.4 Shapefile 

This functionality is in maintenance. 

 

15.3 Exporting primary data  

 

Source data and model results can be exported to three different formats if the 

conditions that apply to the data formats are met.  

 

15.3.1 ASCII grid 

Grid data can be exported to an ASCII grid interchange format. Activate e.g. the main 

or pop up menu option Export Primary Data > ASCII grid for the container: 

Referentie/Top100/GridData. The following dialogue appears: 
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Figure 15.6: Export ASCII grid dialogue 

 

The Grid domain indicates the domain unit(s) for the selected grid items. The 89 grid 

subitems of this container will be exported if the Ok button is selected. The following 

options are available: 

 

The Export also source data (check) or calculated data only (uncheck) option 

is only available if the container would also contain source data, this is in this example 

not the case. If a container would also contain source data, this option can be used to 

indicate if these source items need to be exported as well (the option need to be 

checked). 

 

The Storage location specifies the path to which the files will be exported. By default, 

the data items will be exported to a subdirectory of the results directory of the active 

configuration, named according to the container name, with as filename the name of 

the tree item and the extension .asc.  A new directory and or file name can be chosen 

with the  button next to the Storage location textbox, which activates a Windows 

file dialogue. 

 

The button  shows the list of data items that will be exported. This 

option can only be used to view the list of items, not to make selections. 

 

 

15.3.2 Bitmap/Tiff 

In the GeoDMS, Tiff and bitmaps of 255 colors are supported as export formats. This 

means a data item must be classified into a maximum of 255 classes, and for each 

class, a color value is written in the bitmap.  
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To export data to tiff or bitmap, three items must be configured: 

- the storage location, path and file name of the result file 

- a classification (unless the data item is a classified data item of values type 

(u)int8) 

- a palette (with the color values for each class in the classification) 

 

Classifications and palettes can be configured for a data item or for the values unit of 

the data item. Activate e.g. the pop up menu option Export Primary Data > Bitmap for 

the tree item: Referentie/Top100/GridData. The following dialogue appears: 

 

 
Figure 15.7: Export Bitmap dialogue 

 

The Storage location specifies the name of the file that will be created. By default, 

the data item will be exported to the results directory of the active configuration, with 

as filename the name of the tree item and the extension .tif. Change the extension to 

.bmp to export to a bitmap file. A new directory and or file name can be chosen with 

the button next to the textbox, which activates a Windows file dialogue. Together with 

the bitmap file, a bitmap/tiff world file is exported (with the extension tfw/bmpw), 

containing the coordinate information. This file is used e.g. by ArcView or ArcExplorer 

to ‘map’ the bitmap in a used coordinate system.  

 

In the Relate to combo box a base grid can be selected, if available  

 

The Classification combo box presents the classifications configured for the data item 

or for the values unit of the data item. The default classification is selected, but another 

classification can be chosen with the combo box. If a data item is already classified, 

the text doesn’t use classification appears. A classification is not necessary but, if 

available, still can be chosen. 

 

The Palette combo box presents the available palettes for the selected classification. 

Often only one palette is available, but it is possible to configure multiple palettes for 

a classification (in the current version this is only possible with a text editor in the 

configuration files, not with the user interface of the application). 
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15.3.3 ASCII attribute 

With the menu option Export Primary Data > ASCII attribute the content of a data 

item is written as an array to a plain text file (ASCII format). Activating the main or 

pop-up menu option activate a Windows file dialogue, with: 

- By default, the results directory as location 

- By default, the name of the tree item with the extension .txt as file name 

ASCII attribute files can be made for almost all data items, except for geographic data 

formats (points, arcs and polygons).  

 

 


